
ECON 653 - HOMEWORK 2 
(Due: September 22, 2009) 

 
1. Portfolio Analysis: Portfolio problems are typically solved using C++, Matlab, or specialized software. 

However, given that the main focus of this section of the homework is to help visualize some of the 
standard results in portfolio analysis, you are asked to use Excel to solve it. Please submit your 
responses to the portfolio problems as spreadsheets attached to e-mails. 
Note: The instructions below are edited from Holden, C.W., "Spreadsheet Modeling," available from 
website http://www.spreadsheetmodeling.com/. 

 
1.1. Graph the efficient trade-off line and the risky asset trade-off curve, assuming that there is a risk-free 

asset with a net rate of return rf = 4%, and two risky assets A and B with mean net rates of return μA = 
12% and μB = 7%, standard deviations σA = 18% and σB = 14%, and correlation coefficient ρ = 0. To 
do this, proceed as follows: 
a. Inputs: Enter the inputs described above into the ranges B5:B7 and C6:C8. 

 

 
b. Expected Return – Riskless Rate: Calculate the Expected Return minus the Riskless Rate by 

entering =B5-$B$5 in cell D5 and copying that cell to the range D6:D7. 
c. Proportion in Risky Asset A: To graph the Risky Asset Trade-off Curve, we need to evaluate a 

wide range of values (−60.0% to 140%) for the Proportion in Risky Asset A. Enter –60.0% in cell 
B23, –50.0% in cell B24, and highlight the range B23:B24. Then hover the cursor over the lower 
right corner and it turns to a “fill handle” (which looks like a “+” sign). Drag the fill handle down to 
B43. 

d. Standard Deviation: The horizontal axis of our graph is the portfolio’s standard deviation, which 
is calculated by the formula σ = [w2 2

Aσ  + (1 − w)2 2
Bσ  + 2 w (1 − w) ρ σA σB]0.5. Enter 

=SQRT(B23^2*$C$6^2+(1-B23)^2*$C$7^2+2*B23*(1-B23)*$C$8*$C$6*$C$7) in cell C23 and 
copy the cell to the range C24:C43. 

e. Expected Return: The formula for a portfolio’s expected return is μ = w μA + (1 − w) μB. Enter 
=B23*$B$6+(1-B23)*$B$7 in cell D23 and copy the cell to the range D24:D43. 

f. Optimal Combination of Risky Assets: Using the notation EA ≡ μA − rf and EB ≡ μB − rf , the 
formula for the optimal proportion in asset A is w = (EA 2

Bσ  − EB ρ σA σB)/[EA 2
Bσ  + EB 2

Aσ  − (EA + 
EB) ρ σA σB]. In cell B44, enter =(D6*C7^2-D7*C8*C6*C7)/(D6*C7^2+D7*C6^2-
(D6+D7)*C8*C6*C7) 

g. Calculate the corresponding Mean and Standard Deviation by copying the range C43:D43 to the 
range C44:D44. We want to create a separate column for the Efficient Trade-Off Line, so move 
the formula in cell D44 to cell E44. To do this, select cell D44, click on Edit Cut, select cell E44, 
and click on Edit Paste. 

h. Efficient Trade-Off Line: The Efficient Trade-Off Line is a combination of the Riskless Asset and 
the Risky Asset Optimal Combination. It can be calculated as follows: 
• Enter 0.0% in cell B45, 100.0% in cell B46, and 200.0% in cell B47. Since the Riskless Asset 

has a standard deviation of zero, the standard deviation formula simplifies to σ = w σT, where 
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σT is the standard deviation of the Optimal Combination of Risky Assets (or Tangent 
Portfolio). Enter =B45*$C$44 in cell C45 and copy the cell to the range C46:C47. 

• The Expected Return formula for the portfolio including the riskless asset is μP = wP μT + (1 − 
wP) rf, were μT is the expected return of the Tangent Portfolio and wP is the proportion 
invested in the Tangent Portfolio. Enter =$E$44*B45+$B$5*(1-B45) in cell E45 and copy to 
the range E46:E47. 

 

 
i. Create the Graph: Highlight the range C23:E47 and then choose Insert Chart from the main 

menu. Select a Scatter chart type and make other selections to complete the Chart Wizard. 
Place the graph in the range E2:K16. 

j. (Optional) Formatting the Graph: Here are some tips to make the chart look attractive: 
• Click on one of the Chart curves, then click on Format Selection in the Current Selection 

tab of the Format group. In the Format Data Series dialog box under the Marker Options 
tab, select None for the Marker and click on Close. Repeat for the other curve. 

• Highlight individual points, such as the Riskless Asset, Tangent Portfolio, and Risky Assets A 
and B, by clicking on a chart curve, then click a second time on an individual point (the four-
way arrows symbol appears), then click on Format Selection in the Current Selection tab 
of the Format group. In the Format Data Series dialog box select a market Style, Foreground 
Color, Background Color, and increase the size to 8 pts and click on Close. 

• Click on the x-axis, then click on Format Selection in the Current Selection tab of the 
Format group. In the Format Axis dialog box under the Axis Options tab, enter 0.25 for the 
Maximum and click on Close. 

 
1.2. Use the graph constructed in Problem 1.1 to analyze the effect on (a) the efficient trade-off line, (b) 

the risky asset trade-off curve, and (c) the optimal proportion invested in asset A in the tangent 
portfolio in the following situations: 
• The expected return of an individual risky asset is reduced. 
• The standard deviation of an individual risky asset is increased. 
• The correlation between the two risky assets is increased. 
• The risk-free rate is reduced. 
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1.3. Graph the efficient trade-off line and the risky asset trade-off curve, assuming that there is a risk-free 
asset with a net rate of return rf = 4%, and five risky assets with mean net return vector μ = [7% 8% 
9% 10% 11%]', standard deviation vector σ = [18% 18% 18% 18% 18%]', and correlation matrix ρ = 
[1 0 0 0 0, 0 1 0 0 0, 0 0 1 0 0, 0 0 0 1 0, 0 0 0 0 1]. To do this, proceed as follows: 
a. Inputs: Enter the expected return inputs into the range C5:C10, the standard deviation inputs 

into the range D6:D10, the correlation inputs in the triangular range from B15 to B18 to E18, and 
0.0% in the cell D5. 

 
b. One plus the Expected Return and 100%: It will be useful to have a column based on one plus 

the expected return and another column with just the number 100%. Enter =1+C5 in cell E5 and 
copy the cell to the range E6:E10. Enter 100% in cell F6 and copy the cell to the range F7:F10 

c. Fill Out the Correlation Matrix: The correlation matrix from B14:F18 has a simple structure. All 
of the elements on the diagonal represent the correlation of an asset return with itself. For 
example, B14 is the correlation of the Asset A return with the Asset A return, which is one. C15 is 
the correlation of Asset B with B, and so on. Enter 100.0% into the diagonal cells from B14 to 
F18. The off-diagonal cells in the upper triangular range from C14 to F14 to F17 are the “mirror 
image” of the lower triangular range from B15 to B18 to E18. In other words, the correlation of 
Asset B with Asset A in C14 is equal to the correlation of Asset A with Asset B in B15. Enter 
=B15 in cell C14, =B16 in D14, =B17 in E14, etc. Each cell of the upper triangular range from 
C14 to F14 to F17 should be set equal to its mirror image cell in the lower triangular range from 
B15 to B18 to E18 

d. Transposed Standard Deviations: In addition to the standard deviation input range which runs 
vertically from top to bottom, it will be useful to have a range of standard deviations that runs 
horizontally from left-to-right. This can be done easily by using one of Excel's Matrix commands 
to transpose a range. Highlight the range B22:F22. Then, type =TRANSPOSE(D6:D10), hold 
down the Shift and Control buttons simultaneously, and while continuing to hold them down, 
press Enter. The resulting formula should have braces around it {=TRANSPOSE(D6:D10)} 

e. Covariance Matrix: The Covariance Matrix in the range B26:F30 has a simple structure. All of 
the elements on the diagonal represent the covariance of an asset return with itself, which equals 
the variance. For example, B26 is the covariance of the Asset A return with the Asset A return, 
which equals the variance of Asset A. C27 is the variance of Asset B, and so on. The off-diagonal 
cells are covariances. For example, C26 is the covariance of the Asset A return with the Asset B 
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return and is calculated with the formula for the Covariance(A, B) = Correlation(A, B) × (Std. Dev. 
A) × (Std. Dev. B). Enter =C14*C$22*$D6 in cell C26. Be very careful to enter the $ absolute 
references exactly right. Then copy C26 to the range B26:F30 

f. Hyperbola Coefficients: In a Mean-Standard Deviation graph, the Efficient Frontier is a 
hyperbola. The exact location of the hyperbola is uniquely determined by three coefficients α, θ, 
and φ. They are easy to implement using Excel's matrix functions. In each case, you type the 
formula and then, hold down the Shift and Control buttons simultaneously, and while continuing 
to hold them down, press Enter 
• For α: =MMULT(MMULT(TRANSPOSE(F6:F10),MINVERSE(B26:F30)),F6:F10) in cell C37 
• For θ: =MMULT(MMULT(TRANSPOSE(F6:F10),MINVERSE(B26:F30)),E6:E10) in cell C38 
• For φ: =MMULT(MMULT(TRANSPOSE(E6:E10),MINVERSE(B26:F30)),E6:E10) in cell C39 

 
g. Miscellaneous: It will simplify matters to create range names for various cells. Put the cursor in 

cell C37, click the Name box at the left end of the formula bar , 
enter the name “ALPHA” and preess RETURN. Repeat this procedure to give cell C38 the name 
“THETA”, give cell C39 the name “PHI”. Give cell C40 the name “DELTA”, give cell C41 the name 
“GAMMA”, and give cell E5 the name “R.” (Excel does not accept plain “R”). Enter =ALPHA*PHI-
THETA^2 in cell C40 and enter =1/(THETA-ALPHA*R.) in cell C41. Some restrictions do apply 
on the range of permissible input values. The variable Delta must always be positive or else the 
calculations will blow-up or produce nonsense results. Simply avoid entering large negative 
correlations for multiple assets and this problem will be taken care of. 

h. Individual Risky Assets: To add the individual risky assets to the graph, reference their 
individual standard deviations and expected returns. Enter =D6 in cell D44 and copy down to the 
range D45:D48. Enter =C6 in cell G44 and copy down to the range G45:G48 

i. Expected Return: Using the three Hyperbola coefficients, we can solve for the expected return 
on the upper and lower branches of the hyperbola which correspond to a standard deviation of 
25% and then fill in intermediate values in order to generate the Efficient Frontier graph. 
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• For the upper branch, enter =(2*THETA-(4*THETA^2-4*ALPHA*(PHI-
(0.25^2)*DELTA))^(0.5))/(2*ALPHA)-1 in cell E49 

• For the lower branch, enter =(2*THETA+(4*THETA^2-4*ALPHA*(PHI-
(0.25^2)*DELTA))^(0.5))/(2*ALPHA)-1 in cell E69 

• Fill out in index for expected return by entering 0 in cell C49, entering 1 in cell C50, selecting 
the range C49:C50, and dragging the fill handle (in the lower right corner) down the range 
C51:C69 

• Fill in the intermediate values by entering =$E$49+($E$69-$E$49)*(C50/20) in cell E50 and 
copying the cell down the range E51:E68 

j. Standard Deviation: Again using the three Hyperbola coefficients, we can solve for the Efficient 
Frontier standard deviation which corresponds to any particular value of expected return. Enter 
=((ALPHA*(1+E49)^2-(2*THETA*(1+E49))+PHI)/(ALPHA*PHI-(THETA^2)))^(1/2) in cell D49 
and copy it down the range D50:D69 

k. Tangent Portfolio: The Optimal Combination of Risky Assets (or Tangent Portfolio) can be 
calculated using Excel's matrix functions. In each case, you type the formula and then, hold 
down the Shift and Control buttons simultaneously, and while continuing to hold them down, 
press Enter 
• For the portfolio weights: Select the range I44:I48, then type 

=GAMMA*MMULT(MINVERSE(B26:F30),(E6:E10-R.*F6:F10)) 
• For expected returns: Enter =MMULT(TRANSPOSE(I44:I48),E6:E10)-1 in cell F70 
• For standard deviations: Enter 

=SQRT(MMULT(MMULT(TRANSPOSE(I44:I48),B26:F30),I44:I48)) in cell D70 
l. Efficient Trade-Off Line: The Efficient Trade-Off Line is a combination of the Riskless Asset and 

the Risky Asset Optimal Combination. It can be calculated as follows 
• Enter 0.0% in cell C71, 100.0% in cell C72, and 200.0% in cell C73 
• As before, the standard deviation formula simplifies to σ = w σT. Enter =C71*$D$70 in cell 

D71 and copy the cell to the range D72:D73 
• The Expected Return formula is μP = wP μT + (1 − wP) rf. Enter =$F$70*C71+$C$5*(1-C71) in 

cell F71 and copy to the range F72:F73 
m. Create and Locate the Graphs: Highlight the range D44:G73 and then choose Insert Chart 

from the main menu. Select a Scatter chart type and make other selections to complete the 
Chart Wizard. Place the graph in the range G3:L16. Highlight the range H44:I48 and then choose 
Insert Chart from the main menu. Select a Column chart type and make other selections to 
complete the Chart Wizard. Place the graph in the range G17:L28. Optionally, one can format the 
graph as discussed in the problem 1.1. 

 
1.4. Use the spreadsheet constructed in Problem 1.3 to perform an analysis analogous to Problem 1.2. 
 
1.5. To expedite the analysis requested in Problem 1.4, construct a "dynamic" mean-variance portfolio 

graph. To this end, proceed as follows: 
a. Start with the Spreadsheet Constructed in Problem 1.3, Add Rows, and Rearrange a Bit: 

Open the spreadsheet that you created in Problem 1.3 and immediately save it under a new 

name using the Microsoft Office Button  Save As command. Move both of the graphs out of 
the way. Select each graph and drag them below row 22 and to the right of column H. Select the 
range E3:F10 and drag the range (hover the cursor over the lower highlighted line, click on the 
left mouse button, and hold it down while you move it) to cell H23. 

b. Increase Row Height for the Spinners: Select the range A5:A10. Then click on Cells Format 
Row Height from the Home menu. Enter a height of 30 and click on OK. Select the range 
A14:A18. Then click on Cells Format Row Height from the Home menu. Enter a height of 30 
and click on OK. 

c. Display the Developer Tab if it is Not Available: Click the Microsoft Office Button , and then 
click Excel Options. In the Popular category, under Top Options for Working with Excel, select the 
Show Developer tab in the Ribbon check box, and then click OK. 
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d. Create the Spinners: Look for the up-arrow/down-arrow button on the Developer Controls 
Insert toolbar (which will display the word “Spin Button (Form Control)” if you hover the cursor 
over it) and click on it. Then draw the box for a spinner covering the left half of cell C5. Then a 
spinner appears in the left half of cell C5. Right click on the spinner (press the right mouse button 
while the cursor is above the spinner) and a small menu pops up. Click on Copy. Then select the 
cell C6 and click on Paste. This creates an identical spinner in the cell C6. Repeat the process 
four times more in cells C7:C10. Repeat the process five times more in cells D6:D10. Click on 
the spinner button on the Developer Controls Insert toolbar and draw the box for a spinner 
covering the left half of cell B15. Click on Copy. Then select the cell B16 and click on Paste. 
Repeat the process eight times more in cells B17, B18, C16, C17, C18, D17, D18, and E18. 

 

 
e. Create the Cell Links: Right click on the first spinner in cell C5 and a small menu pops up. Click 

on Format Control and a dialog box pops up. Click on the Control tab, then enter the cell link 
K5 in the Cell link edit box and click on OK. Repeat this procedure for the spinners in the range 
C6:C10 (linking to cells in the range K6:K10) and in the range D6:D10 (linking to cells in the 
range L6:L10). Right click on the spinner in the cell B15 and a small menu pops up. Click on 
Format Control and a dialog box pops up. Click on the Control tab, then enter cell K15 as the 
cell link in the Cell link edit box and click on OK. Repeat this procedure for the spinners in the 
range B16:B18 and in the triangle C16 to C18 to E18 (linking each spinner to the cells in the 
range K16:K18 and in the triangle L16 to L18 to N18, respectively). Test your spinners by 
clicking on the up-arrows and down-arrows of the spinners to see how they change the values in 
the linked cells. 

f. Create Scaled Inputs: The values in the linked cells are always integers, but they can be scaled 
appropriately to the problem at hand. In cell C5, enter =K5/500 and copy this cell to the range 
C6:C10. In cell D6, enter =L6/500 and copy this cell to the range D7:D10. In cell B15, enter 
=K15/10-1 and copy the cell to the range B16:B18 and to the triangle C16 to C18 to E18. 

g. Relocate Graphs: Move both of the graphs back into place. Move the Efficient Frontier graph 
into the range G11:K22. Move the Portfolio Weights graph into the range I5:K10. 

 
1.6. Assume that the portfolio optimization is subject to constraints (e.g., no short sales, or upper limits on 

the holdings of individual assets). Graph the efficient trade-off line, assuming that there is a risk-free 
asset with a net rate of return rf = 4%, and five risky assets with mean return vector μ = [7.6% 8% 1% 
0.6% 16%]', standard deviation vector σ = [12% 16% 18% 18% 20%]', and correlation matrix ρ = [1 
0.2 –0.1 0.1 0, 0.2 1 0.4 0.1 0, –0.1 0.4 1 0.2 0.2, 0.1 0.1 0.2 1 0.3, 0 0 0.2 0.3 1]. Analyze how such 
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constraints affect the location of the efficient set in mean-variance space. To this end, construct the 
spreadsheet as indicated in the following instructions. 
a. Start with the Spreadsheet Constructed in Problem 1.3: Open the spreadsheet that you 

created in Problem 1.3 and immediately save it under a new name using the Microsoft Office 

Button  Save As command. In the range A80:M94 type the titles shown in the figure below. 

 
b. Calculate Portfolio Variance: In cell F86 type 

=MMULT(MMULT(H86:L86,$B$26:$F$30),TRANSPOSE(H86:L86)). Since this is intended to be 
a matrix function, after typing you must hold down the Shift and Control buttons simultaneously, 
and while continuing to hold them down, press Enter. 

c. Restricted Optimal Proportion of Risk-Free Asset: In cell G86 type =1-SUM(H86:L86). 
d. Standard Deviation and Expected Return of Optimal Restricted Portfolio: In cells C86 and 

D86 type =SQRT(F86) and =MMULT(H86:L86,$C$6:$C$10)+C5*G86, respectively. 

e. Insert Solver Add In if it is Not Available: Click the Microsoft Office Button , and then click 
Excel Options. Click Add-Ins, and then in the Manage box, select Excel Add-ins and click Go. In the Add-
Ins available box, select the Solver Add-in check box, and then click OK. (Note: If Solver Add-in is not 
listed in the Add-Ins available box, click Browse to locate the add-in. If you get prompted that the Solver 
Add-in is not currently installed on your computer, click Yes to install it.) Once you insert the Solver Add In, 
the Solver command is available in the Analysis group on the Data tab. 

f. Restricted Portfolio Optimization: In cell M86 type the desired expected return of the restricted 
portfolio (e.g., 16%). Then select Analysis Solver from the Data tab. A menu like the one shown in 
the figure above will appear on the screen. Type the values shown in the figure (Note: Due to 
space limitations, the figure above does not show the additional constraint $L$86 >= 0. Click 
Solve, and then Keep Solver Solution OK. Select range C86:M86, click on Edit Copy, select 
cell C94, click on Edit Paste Special, and click Values OK. Repeat the procedure for desired 
restricted portfolio returns of 4%, 6%, 8%, 10%, 12%, 14%, and 25% to obtain a table lie the one 
shown in the figure above. 

g. Add the Restricted Frontier to the Mean-Variance Graph: Select the mean-standard deviation 
chart and select Chart Source Data from the main menu. Click on Series Add and select the 
range C86:C94 as X Values axis and D86:D94 as Y Values. Edit the points so that they show as 
a curve. 
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1.7. Based on your response to Problem 1.6, are convex combinations of the restricted frontier portfolios 
necessarily on the restricted portfolio frontier? 

 
2. Solve Exercise 6 on p. 55 of Pennacchi. 
 
3. (Exercise 6 on p. 171 of Luenberger) Suppose there are n assets which are uncorrelated. (They 

might be n different “wild cat” oil prospects.) You may invest in any one, or in any combination of 
them. The mean rate of return r  is the same for each asset, but the variances are different. The 
return on asset i has a variance of 2

iσ  for i = 1, 2, …, n. 
a. Show the situation in an r -σ diagram. 

b. Find the minimum-variance point. Express your result in terms of 2σ  = 
σ

−
⎛ ⎞
⎜ ⎟
⎝ ⎠
∑

n

i i

1

2
=1

1
. 

 
 
References: 
Luenberger, D. G. Investment Science. New York: Oxford University Press, 1998. 
Pennacchi, G. Theory of Asset Pricing. Boston: Pearson, 2007. 


